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Temperature Controller MODBUS SIO Driver

Introduction
This manual describes how to connect the Display and the External Device (target Temp. Controller).
In this manual, the connection procedure is described in the sections identified below:

1 System Configuration
This section lists the types of External
Devices and SIO that you can connect.

& System Configuration” (page 3)

2 External Device Selection =
Select a model (series) of the External
Device and its connection method.

"2 External Device Selection" (page 7)

3 || Communication Settings

This section shows setting examples for
communicating between the Display and
the External Device.

&~ "3 Communication Settings" (page 8)

4 Setup ltems &=
This section describes communication
setup items on the Display.

Set the Display’s communication settings
in GP Pro-EX or in off-line mode.

"4 Setup ltems" (page 24)

5 || Cable Diagrams

This section shows cables and adapters
for connecting the Display and the
External Device.

&5 Cable Diagrams" (page 29)

Operation
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Temperature Controller MODBUS SIO Driver

1 System Configuration

The following table lists system configurations for connecting Fuji Electric Co.,Ltd. External Devices and the

Display.
Cable
Series CPU Link I/F SIO Type | Setting Example e
e . | " Cable
PC Loader Eort RS-232C Setting Example 1 Diagram 1"
on CPU Unit (page 8) (page 29)
PXH PXHOOOOO-OOmMOO™ .
. . | " Cable
Port on CPU Unit RS-4'22/485 Setting Example 2 Diagram 2
(2 wire) (page 10) (page 31)
— . | " Cable
X PC Loader Eort RS-232C Setting Example 3 Diagram 1"
PXG400mMO-00000-0°2 |on CPU Unit (page 12) (page 29)
PXG pXGsOOmMO-00000-0°? .
pxGoOOmO-00000-0%? ) "Setti w | " Cable
Port on CPU Unit RS 422/485 Setting Example 4 Diagram 3"
(2 wire) (page 14) (age 43)

PXR3OOOO-O0O0MO0-0"
PXRAOOOO-OCOMONO ™" " Cable

(P/;fjfoﬂx) PXRSOOOC-OCIMOD® | Port on CPU Unit ?25\;;?;/ 485 (Sstt;”f6)Examp'e *" | Diagram 3"
PXR7O0000-OO0MOD " Pag (page 43)
PXROOOOO-OOMOO™
PXR R . | " Cable
(NoAuto- | PXRAOOOIO-OCIMOIDT ™46 | Port on CPU Unit (RZS\;V“if;"‘SE’ (S:“;”fg)Examp'e %" | Diagram 3"
FIX) Pag (page 43)
PUMADDOO-00000 PC Loader Port RS-232C "Setting Example 7" D?;at;?m 1"
PUMBOOOO-00000 on CPU Unit (page 20) g
PUM PUMEOOOO-OO (page 29)
pUMVOOOO-O000O0OO . " Cable
PUMNOOOO-D0O000 Port on CPU Unit | R5422/485 | "Setting Example 8 Diagram 4"
PUMTOOOO-00000 (2 wire) (page 22) (page 55)
*1  The CPU type can be connected with RS-422/485 (2 wire) when the B section includes the following code:
R (RS-485)
*2  The CPU type can be connected with RS-422/485 (2 wire) when the B section includes the following codes:
M (RS-485)

V (RS-485 + Digital input (No.1))

K (RS-485 + RSV1)

J (RS-485 + CT1)

F (RS-485 + Digital input (No.1) + RSV1)
U (RS-485 + Digital input (No.1, 2, 3))

*3  The CPU type can be connected with RS-422/485 (2 wire) when the B section includes the following codes:
M (RS-485 Modbus interface)
V (RS-485 Modbus interface + Digital input 1 point)

*4  PXR4 Socket type cannot be connected because it lacks a serial port option.
*5  CPU Unit released in July 2001 or later
*6  CPU Unit released in June 2001 or earlier
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Temperature Controller MODBUS SIO Driver
|

B Connection Configuration

e 1:1 Connection

]

)

External Device

Display

e 1:n Connection

1 ] [ ] [ ]

l J | J { )

External Device External Device External Device

u J

Display Maximum number of External Devices: 16
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H |PC COM Port

When connecting IPC with an External Device, the COM port used depends on the series and SIO type. Please

refer to the IPC manual for details.

Temperature Controller MODBUS SIO Driver

Usable port
; Usable Port
Series
RS-232C RS-422/485(4 wire) | RS-422/485(2 wire)
com1™, comz,
PS-2000B ComM3™L Coma - -
PS-3450A, PS-3451A, % qx %
PS3000-BA, PS3001-BD COML, COM2 com2 comz
PS-3650A (T41 model), “q ] ]
PS-3651A (T41 model) coml
PS-3650A (T42 model), %2 1% i
PS-3651A (T42 model) com1™t"2 com2 CcCoMm1 ComM1
PS-3700A (Pentium®4-M) | COM1™, com2™, 2 o
PS-3710A COM3™2  coM4 COM3 coms
PS-3711A com1™, com2™ COM2*? COM2*2
PS40003 COM1, COM2 - -
com1™2 com2™, w10 %
PL3000 COM3, COM4 COM1 ComM1

*1  The RI/5V can be switched. Use the IPC’s switch to change if necessary.
*2  Set up the SIO type with the DIP Switch. Please set up as follows according to SIO type to be used.

*3  When making communication between an External Device and COM port on the Expansion slot,
only RS-232C is supported. However, ER (DTR/CTS) control cannot be executed because of the
specification of COM port.

For connection with External Device, use user-created cables and disable Pin Nos. 1, 4, 6 and 9.
Please refer to the IPC manual for details of pin layout.

DIP Switch setting: RS-232C

DIP Switch Setting Description
1 OFF™ Reserved (always OFF)
2 OFF
SIO type: RS-232C
3 OFF
4 OFF Output mode of SD (TXD) data: Always output
5 OFF Terminal resistance (220€2) insertion to SD (TXD): None
6 OFF Terminal resistance (220€2) insertion to RD (RXD): None
7 OFF Short-circuit of SDA (TXA) and RDA (RXA): Not available
8 OFF Short-circuit of SDB (TXB) and RDB (RXB): Not available
9 OFF
RS (RTS) Auto control mode: Disabled
10 OFF

*1  When using PS-3450A, PS-3451A, PS3000-BA and PS3001-BD, turn ON the set value.
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Temperature Controller MODBUS SIO Driver

DIP Switch setting: RS-422/485 (4 wire)

DIP Switch Setting Description
1 OFF Reserved (always OFF)
2 ON
SIO type: RS-422/485
3 ON
4 OFF Output mode of SD (TXD) data: Always output
5 OFF Terminal resistance (220€2) insertion to SD (TXD): None
6 OFF Terminal resistance (220€2) insertion to RD (RXD): None
7 OFF Short-circuit of SDA (TXA) and RDA (RXA): Not available
8 OFF Short-circuit of SDB (TXB) and RDB (RXB): Not available
9 OFF
RS (RTS) Auto control mode: Disabled
10 OFF

DIP Switch setting: RS-422/485 (2 wire)

DIP Switch Setting Description
1 OFF Reserved (always OFF)
2 ON
SIO type: RS-422/485
3 ON
4 OFF Output mode of SD (TXD) data: Always output
5 OFF Terminal resistance (220Q2) insertion to SD (TXD): None
6 OFF Terminal resistance (220Q2) insertion to RD (RXD): None
7 ON Short-circuit of SDA (TXA) and RDA (RXA): Available
8 ON Short-circuit of SDB (TXB) and RDB (RXB): Available
9 ON
RS (RTS) Auto control mode: Enabled
10 ON
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Temperature Controller MODBUS SIO Driver

2 External Device Selection

Select the External Device to be connected to the Display.

,j_i': Welcome to GP-Pro EX B
4 Devica/PLC
» evice,
GP-Prole |

Mumber of Devices/PLCs I] 3: g
Device/PLE 1

Manufacturer | Fuiji Electric Co. Ltd. |L

Series Temp. Contraller MODBUS 510 E

Fot COM1 [l
Beter to the marnual of this DevicePLC
Recent Device/PLC

A 13

™ lWse System fAea Device Infarmation
£iim

QY

Back [B) Communication Settings | Mew Screen I Canicel

Setup ltems Setup Description

Enter an integer from 1 to 4 to define the number of Devices/PLCs to connect to the

Number of Devices/PLCs .
display.

Select the manufacturer of the External Device to connect. Select "Fuji Electric

Manufacturer Co.,Ltd.".

Select the External Device model (series) and the connection method. Select "Temp.
Controller MODBUS SIO".

Series In System configuration, make sure the External Device you are connecting is
supported by "Temp. Controller MODBUS SIO".

Fm System Configuration” (page 3)

Port Select the Display port to be connected to the External Device.

Use System Area Not available for this driver.
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Temperature Controller MODBUS SIO Driver

3 Communication Settings

This section provides examples of communication settings recommended by Pro-face for the Display and the
External Device.

3.1 Setting Example 1
B GP Pro-EX Settings
4 Communication Settings

To display the setup screen, from the [Project] menu, point to [System Settings] and select [Device/PLC].

iii loTc e iy
dagaapas

@ Device Setting

To display the [Individual Device Settings] dialog box, from [Device-Specific Settings] in the [Device/PLC]
window, select the external device and click [Settings] ﬁ

To connect multiple External Devices, from [Device-Specific Settings] in the [Device/PLC] window, click [Add
Device] to add another External Device.

#* Individual Device Settings
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Temperature Controller MODBUS SIO Driver

B External Device Settings

For External Device communication settings, use the SEL key, UP key, DOWN key, Digit selection key, or DISP
key located in the operation area on the front of the controller.
Refer to your External Device manual for details.

1 Press SEL key.

2 Press UP key or DOWN key to display [COM].

3 Press SEL key.

4 Press UP key or DOWN key to display the setting parameter.

5 Press SEL key to switch to setting mode.

6 Press UP key, DOWN key or Digit selection key to display the setting value.
7 Press SEL key.

8 Press DISP key twice.

9 Reboot the External Device.

@ Setting Value

Setting Parameter Setting Value Setup Description
SPD2 384 RS-232C communication speed
BIT2 80 RS-232C bit format

GP-Pro EX Device/PLC Connection Manual 9



Temperature Controller MODBUS SIO Driver
|

3.2 Setting Example 2
B GP Pro-EX Settings

© Communication Settings

To display the setup screen, from the [Project] menu, point to [System Settings] and select [Device/PLC].

@ Device Setting
To display the [Individual Device Settings] dialog box, from [Device-Specific Settings] in the [Device/PLC]
window, select the external device and click [Settings] ﬁ
To connect multiple External Devices, from [Device-Specific Settings] in the [Device/PLC] window, click [Add
Device] to add another External Device.

#* Individual Device Settings
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B External Device Settings
For External Device communication settings, use the SEL key, UP key, DOWN key, Digit selection key, or DISP
key located in the operation area on the front of the controller.
Refer to your External Device manual for details.

1 Press SEL key.

2 Press UP key or DOWN key to display [COM].

3 Press SEL key.

4 Press UP key or DOWN key to display the setting parameter.

5 Press SEL key to switch to setting mode.

6 Press UP key, DOWN key or Digit selection key to display the setting value.
7 Press SEL key.

8 Press DISP key twice.

9 Reboot the External Device.

@ Setting Value

Setting Parameter Setting Value Setup Description
STN4 1 RS-485 station No.

SPD4 384 RS-485 communication speed
BIT4 80 RS-485 bit format

GP-Pro EX Device/PLC Connection Manual 11
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3.3 Setting Example 3
B GP Pro-EX Settings
© Communication Settings

To display the setup screen, from the [Project] menu, point to [System Settings] and select [Device/PLC].

iii o T
dagaapas

@ Device Setting
To display the [Individual Device Settings] dialog box, from [Device-Specific Settings] in the [Device/PLC]
window, select the external device and click [Settings] ﬁ

To connect multiple External Devices, from [Device-Specific Settings] in the [Device/PLC] window, click [Add
Device] to add another External Device.

#* Individual Device Settings
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B External Device Settings

External Device communication settings are fixed as indicated below.

Setting Items Setting Value
Communication speed 9600
Data length 8
Stop bit 1
Parity None
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3.4 Setting Example 4
B GP Pro-EX Settings
© Communication Settings

To display the setup screen, from the [Project] menu, point to [System Settings] and select [Device/PLC].

iii loTc e iy
dagaapas

@ Device Setting
To display the [Individual Device Settings] dialog box, from [Device-Specific Settings] in the [Device/PLC]
window, select the external device and click [Settings] ﬁ

To connect multiple External Devices, from [Device-Specific Settings] in the [Device/PLC] window, click [Add
Device] to add another External Device.

#* Individual Device Settings
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B External Device Settings
For External Device communication settings, use the SEL key, UP key, DOWN key, or USER key, located in the
operation area on the front of the controller.

Refer to your External Device manual for details.

1 Press and hold SEL key to switch to Monitor Mode.
2 Press and hold SEL key to switch to Setup Mode.
3 Press UP key or DOWN key to display [CoM Ch 9].
4 Press and hold SEL key.
5 Press UP key or DOWN key to display setting parameter.
6 Press SEL key.
7 Press UP key or DOWN key to display setting value.
8 Press SEL key.
9 Press USER key.
10 Reboot the External Device.

@ Setting Value

Setting Parameter Setting Value Setup Description
STno 1 ST No. setting

CoM 960d RS-485 Baud rate/Parity settings
SCC rw RS-485 Communication permissions
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|

3.5 Setting Example 5
B GP Pro-EX Settings

© Communication Settings

To display the setup screen, from the [Project] menu, point to [System Settings] and select [Device/PLC].

@ Device Setting

To display the [Individual Device Settings] dialog box, from [Device-Specific Settings] in the [Device/PLC]
window, select the external device and click [Settings] ﬁ

To connect multiple External Devices, from [Device-Specific Settings] in the [Device/PLC] window, click [Add
Device] to add another External Device.

# Individual D s E

PR SeriesfutoFl) i
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B External Device Settings
For External Device communication settings, use the SEL key, UP key, or DOWN key located in the operation
area on the front of the controller.

Refer to your External Device manual for details.

1 Press and hold SEL key to display the 3rd block parameter.
2 Press UP key or DOWN key to display setting parameter.
3 Press SEL key.

4 Press UP key or DOWN key to display setting value.

5 Press SEL key.

6 Press and hold SEL key.

@ Setting Value

Setting Parameter Setting Value Setup Description
STno 1 Station No.

CoM 0 Parity setting

PColL 1 Communication protocol
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3.6 Setting Example 6
B GP Pro-EX Settings
© Communication Settings

To display the setup screen, from the [Project] menu, point to [System Settings] and select [Device/PLC].

I i i 275
= -
0

@ Device Setting

To display the [Individual Device Settings] dialog box, from [Device-Specific Settings] in the [Device/PLC]
window, select the external device and click [Settings] ﬁ

To connect multiple External Devices, from [Device-Specific Settings] in the [Device/PLC] window, click [Add
Device] to add another External Device.

#* Individual D 3 E

PR Series(NodutoFl) i
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B External Device Settings
For External Device communication settings, use the SEL key, UP key, or DOWN key located in the operation
area on the front of the controller.

Refer to your External Device manual for details.

1 Press and hold SEL key to display the 3rd block parameter.
2 Press UP key or DOWN key to display setting parameter.
3 Press SEL key.

4 Press UP key or DOWN key to display setting value.

5 Press SEL key.

6 Press and hold SEL key.

@ Setting Value

Setting Parameter Setting Value Setup Description
STno 1 Station No.

CoM 0 Parity setting

PColL 1 Communication protocol

GP-Pro EX Device/PLC Connection Manual 19
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|

3.7 Setting Example 7
B GP Pro-EX Settings

© Communication Settings

To display the setup screen, from the [Project] menu, point to [System Settings] and select [Device/PLC].

@ Device Setting
To display the [Individual Device Settings] dialog box, from [Device-Specific Settings] in the [Device/PLC]
window, select the external device and click [Settings] ﬁ
To connect multiple External Devices, from [Device-Specific Settings] in the [Device/PLC] window, click [Add
Device] to add another External Device.

#* Individual Device Settings
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B External Device Settings

For External Device communication settings, use the Station No. Configuration switch on the front of the
controller.
Refer to your External Device manual for details.

1 Set 0" to Station No. Configuration switch.

NOTE » The Station Number is generated by adding 1 (one) to the value set by the Station No.
Configuration switch.

Other communication settings are fixed as below.

Setting Items Setting Value
Communication speed 19200
Data length 8
Stop bit 1
Parity None
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3.8 Setting Example 8
B GP Pro-EX Settings
© Communication Settings

To display the setup screen, from the [Project] menu, point to [System Settings] and select [Device/PLC].

iii o T
dagaapas

@ Device Setting
To display the [Individual Device Settings] dialog box, from [Device-Specific Settings] in the [Device/PLC]
window, select the external device and click [Settings] ﬁ

To connect multiple External Devices, from [Device-Specific Settings] in the [Device/PLC] window, click [Add
Device] to add another External Device.

#* Individual Device Settings
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B External Device Settings

For External Device communication settings, use the Station No. Configuration switch on the front of the
controller and Parameter Loader software (PUM Loader).
Refer to your External Device manual for details.

1 Set 0" to Station No. Configuration switch.

NOTE » The Station Number is generated by adding 1 (one) to the value set by the Station No.
Configuration switch.

2 Start up the Parameter Loader software.
3 Select [Control/Event/Analog Module] in the [Module type selection] dialog box.
4 Click [OK].
5 Select the any mode in the [Startup mode] dialog box.
6 Click [OK].
7 Select [Control module]-[Parameter]-[Communication] in the tree view of the main window.
8 Click the setting item to display the selection dialog box of the setting value.
O Select the setting value.
10 Click [OK].
11 Transfer the communication settings to External Device.

@ Setting Value

Setting Items Setting Value
RS-485 Parity setting None
RS-485 Communication speed 19.2Kbps
RS-485 Communication permission 1
RS-485 Response interval time 1
Enhanced comm. module (PUMC) connection 0
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4 Setup Items

Set up the Display’s communication settings in GP Pro-EX or in the Display’s off-line mode.
The setting of each parameter must match that of the External Device.
&3 Communication Settings" (page 8)

4.1 Setup Items in GP Pro-EX

B Communication Settings
To display the setup screen, from the [Project] menu, point to [System Settings] and select [Device/PLC].

Devica/PLC 1 |
Summary Change Device/PLC
M anufacturer IFuii Electric Co. Ltd. Series Temp. Contraller MODBLS 510 Port  |COR1
Text Data Mode I‘I_ LChange

Communication Settings

SI0 Type &+ R5232C 7 R5422/4552wire] 7 R5422/455 wire]
Speed lm

Data Length 7 [l

Parity & HONE  EVEN  0oD

Stop Bit 1 -

Flow Contral & HONE © ER[DTRACTS] € HONMOFF

Timeout m [zec)

Fietry m

Wwiait Ta Send [0 = ms)

Rl /WCC & Rl & WET

I the case of R5232C, you can select the Sth pin to Rl [Input)
or WCC (5% Power Supply). If you uze the Digital's R5232C
Isolation Unit, please select it to WCC. Diefault

Device-Specific Settings

Alloweable Mumber Add Device
of Devices/PLCs 16

Add Indirect
Mo, Device Mame Seftings Device
[&] 1 Jrc [l [Series=FG Series Station No.=1

Setup Items Setup Description

Select the SI0 type to communicate with the External Device.

IMPORTANT

Tln the communication setting, confirm the serial interface specifications of the Display
SIO Type and set [SIO Type] correctly.

If you select an SIO type the serial interface does not support, we cannot guarantee the
operation.

Please refer to the manual of the Display for more detail on the serial interface
specifications.

Speed Select communication speed between the External Device and the Display.
Data Length Display data length.

Parity Select how to check parity.

Stop Bit Select stop bit length.

Continues to the next page.
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Setup Items Setup Description
Select the communication control method to prevent overflow of transmission and
Flow Control .
reception data.
. Use an integer from 1 to 127 to enter the time (s) for which the Display waits for the
Timeout .
response from the External Device.
In case of no response from the External Device, use an integer from 0 to 255 to enter how
Retry . - .
many times the Display retransmits the command.
Wait To Send Use an integer fro_m_O to 255 to enter standby time (ms) for the Display from receiving
packets to transmitting next commands.
You can switch RI/VCC of the 9th pin when you select RS232C for SIO type.
RI/VCC It is necessary to change RI/5V by changeover switch of IPC when connect with IPC.

Please refer to the manual of the IPC for more detail.

» Refer to the GP-Pro EX Reference Manual for Indirect Device.

GP-Pro EX Reference Manual "Changing the Device/PLC at Runtime (Indirect
Device)"

B Device Setting

To display the [Individual Device Settings] dialog box, from [Device-Specific Settings] in the [Device/PLC]

window, select the external device and click [Settings] [ .

To connect multiple External Devices, from [Device-Specific Settings] in the [Device/PLC] window, click [Add

Device] to add another External Device.

#* Individual Device Settings

PLC1

Series |PXG Series |

If you change the series, please reconfirm all address settings.

Station No. |1 3:
Default |

0K () Cancel |

Setup Items Setup Description
Series Select the series of the External Device.
Station No. Use an integer from 1 to 255 to enter the Station number of the External Device.
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4.2 Setup Items in Off-line Mode

 Refer to the Maintenance/Troubleshooting manual for information on how to enter off-line

mode or about the operation.
Cf. Maintenance/Troubleshooting Manual "Off-line Mode"

» The number of the setup items to be displayed for 1 page in the off-line mode depends on the

Display in use. Please refer to the Reference manual for details.

B Communication Settings

To display the setting screen, touch [Device/PLC Settings] from [Peripheral Equipment Settings] in off-line

mode. Touch the External Device you want to set from the displayed list.

| Cormm, Device Option

Temp. Controller MODBUS SIO [GOM1] Page 1/1
SI0 Type RS422/485(2wire) B
Speed 9600 =
Data Length 8
Parity NONE EVEN e (DD
Stop Bit o | »
Flow Control [ NONE ==
Timeout(s} 3 ¥ | A
Retry 7w | A
Wait To Send(ms) 1 | a

: 20m8/12/22
| Enit | Back 15:12:18
Setup Items Setup Description
Select the S10 type to communicate with the External Device.
IMPORTANT
In the communication setting, confirm the serial interface specifications of the Display and
SIO Type set [SIO Type] correctly.
If you select an S10 type the serial interface does not support, we cannot guarantee the
operation.
Please refer to the manual of the Display for more detail on the serial interface
specifications.
Speed Select the communication speed between the External Device and the Display.

Data Length

Display data length.

Parity

Select how to check parity.

Stop Bit

Select stop bit length.

Continues to the next page.
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Setup Items Setup Description
Select the communication control method to prevent overflow of transmission and reception
Flow Control
data.
. Use an integer from 1 to 127 to enter the time (s) for which the Display waits for the
Timeout .
response from the External Device.
In case of no response from the External Device, use an integer from "0 to 255" to enter how
Retry . - .
many times the Display retransmits the command.
Wait To Send Use an integer fro_m_ 0 to 255" to enter standby time (ms) for the Display from receiving
packets to transmitting next commands.

B Device Setting

To display the setting screen, touch [Device/PLC Settings] from [Peripheral Equipment Settings]. Touch the
External Device you want to set from the displayed list, and touch [Device].

Comm, Device Option
Temp, Gontroller MODBUS SI0 [GOM1] Page 1/1
Device/PLC Name [PLCI ==
Series PHR Series{futoFIX)
Station No. | T v|al
; 20mg/ 12/ 22
Enit Back 1512600
Setup Items Setup Description
Device/PLC Name Select the External Device to set. Device name is a title of the External Device set with GP-
Pro EX. (Initial value [PLC1])
Series Display the series of the External Device.
Station No. Use an integer from 1 to 255 to enter the Station number of the External Device.
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W Option
To display the setting screen, touch [Device/PLC Settings] from [Peripheral Equipment Settings]. Touch the
External Device you want to set from the displayed list, and touch [Option].

Setup ltems Setup Description
You can switch RI/VCC of the 9th pin when you select RS232C for SIO type.
RI/VCC It is necessary to change RI/5V by changeover switch of IPC when connect with IPC.
Please refer to the manual of the IPC for more detail.

NOTE e GP-4100 series, GP-4*01TM, LT-4*01TM and LT-Rear Module do not have the [Option]
setting in the offline mode.
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5 Cable Diagrams

The following cable diagrams may be different from cable diagrams recommended by Fuji Electric Co.,Ltd.

Please be assured there is no operational problem in applying the cable diagrams shown in this manual.

e The FG pin of the External Device body must be D-class grounded. Refer to your External Device manual for
more details.

e The SG and FG are connected inside the Display. When connecting the External Device to the SG, design
your system to avoid short-circuit loops.

* Connect an isolation unit if the communication is not stable due to noise or other factors.

Cable Diagram 1

Display

. Cable Notes
(Connection Port)

GP3000 (COM1)
GP4000"! (COM1)
SP5000 (COM1/2)
ST (COM1) 1A Loader connecting cable by Fuji Electric Systems Co., Ltd.™
LT3000 (COML1)
IPC™?

PC/AT

User-created cable
GP-4105 (COML1) 1B +
Loader connecting cable by Fuji Electric Systems Co., Ltd.™

*1  All GP4000 models except GP-4100 Series and GP-4203T

*2 O%the COM port which can communicate by RS-232C can be used.
"H IPC COM Port" (page 5)

*3  The loader connecting cable differs, depending on the series.

Series Loader connecting cable type
PXH ZZPPXH1*TK4H4563
PUM PUMZ*L01
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1A)
Display Display side External Device side
D-Sub 9pin $2.5 triple pole miniature jack
| —-=
Loader connecting cable
NOTE » Connect the loader connecting cable to the PC loader port of the External Device.
1B)
Display side External Device side
Terminal block Shield D-sub 9 pin (plug)
Signal 3 Pin Signal
Display name name Display side External Device side
RD(RXD) 2 RD(RXD) D-Sub 9pin $2.5 triple pole miniature jack
SD(TXD) 3 SD(TXD)
ER(DTR) 4 |ER(DTR) @ =
SG 5 SG Loader connecting cable
RS(RTS) — 7 |RS(RTS)
CS(CTS) L - 8 CS(CTS)
L
User-created cable
NOTE I  Connect the loader connecting cable to the PC loader port of the External Device.
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Cable Diagram 2

Temperature Controller MODBUS SIO Driver

Displ
ISp. = Cable Notes
(Connection Port)
COM port conversion adapter by Pro-face
. CA3-ADPCOM-01
GP3000" (COM1) +
AGP-3302B (COM2) 2A Terminal block conversion adapter by Pro-face Cable length:
GP-4*01TM (COM1) CA3-ADPTRM-01 500m or less
ST*? (COM2) +
LT3000 (COMLY) User-created cable
2B User-created cable
Online adapter by Pro-face
CA4-ADPONL-01
+
2C Terminal block conversion adapter by Pro-face
CA3-ADPTRM-01
GP3000*3 (COM2) + Cable length:
User-created cable 500m or less
Online adapter by Pro-face
CA4-ADPONL-01
2D +
User-created cable
COM port conversion adapter by Pro-face
CA3-ADPCOM-01
+
s 2E Terminal block conversion adapter by Pro-face Cable length:
IPC CA3-ADPTRM-01 500m or less
+
User-created cable
2F User-created cable
GP-4106 (COML1) 2G User-created cable %%%';'gr”?;:s
GP-4107 (COML1) _
GP-4*03T"® (COM2) 2H User-created cable %%%'; 'g;‘?;:s
GP-4203T (COM1)
RS-422 Terminal Block Conversion Adapter by Pro-face
*| *7
GPA000™® (com2) 2 F>FXZCB+ADTNIl Cable length:
GP-4201T (COMI) User-created cable 500m or less
SP5000 (COM1/2)
2B User-created cable
LT-4*01TM (COM1) RJ45 RS-485 Cable (5m) by Pro-face Cable lenath:
LT-Rear Module (COM1) 2) PFXZLMCBRJR81 200m or gI]ess'

*1  All GP3000 models except AGP-3302B
*2  All ST models except AST-3211A and AST-3302B
*3  All GP3000 models except GP-3200 series and AGP-3302B
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*4

*5
*6
*7

Temperature Controller MODBUS SIO Driver

Or%z}the COM port which can communicate by RS-422/485 (2 wire) can be used.
"m IPC COM Port" (page 5)

Except GP-4203T
All GP4000 models except GP-4100 Series, GP-4*01TM, GP-4201T and GP-4*03T

When using a Terminal Block Conversion Adapter (CA3-ADPTRM-01) instead of the RS-422 Terminal Block
Conversion Adapter, refer to Cable Diagram 2A.

IMPORTANT Implement Type D installment to the shield connected to the FG.

GP-Pro EX Device/PLC Connection Manual 32



2A)

¢ 1:1 Connection

Display

Temperature Controller MODBUS SIO Driver

CA3-ADPCOM-01

e 1:n Connection

Display

CA3-ADPTRM-01

CA3-ADPCOM-01

Display side
Terminal Block . .
p— Shield External Device side
ignal name i
g pummmmmmmmm=——— ","\‘ Termlnal BIOCk Termination
TERMRX : ! Pin [Signal name| resistance
RDA PH A _-' N 100Q2
= A
(L1 RDB |« —> 16 -
CA3-ADPTRM-01 SDA : .15 SG
SDB v
SG
FG
User-created cable
Display side
Terminal Block . ) ) .

- . External Device side External Device side
Signal name _Shleld . Terminal Block Terminal Block
TERMRX [— 2% | Pin [signalname| ~_Shield Pin |Signal name

o T EEEIN P WA 1000
// 1 RDB [« i 16 - e 16 -
SDA |- +— 15 | SG —— 15 | SG
SDB : 1
SG )
FG

v

User-created cable
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Temperature Controller MODBUS SIO Driver

2B)
¢ 1:1 Connection

Display side External Device side
. D-Sub 9pin (socket) Terminal Block I
Termination . Termination
resistance | Pin | Signal name Shield Pin [Signal name| resistance
100Q ST 100Q
1 RDA |e¢— A ——> 14 + %
Display 2 RDB |e—= / \ <yl 16 -
3 | sbA (— i —— 15 | SG
7 SDB .
5 | SG P
4 ERA ::I
8 CSA
9 ERB ::l Vo
6 | csB B L
.......... y’
shell | F6 |—T
» 1:n Connection
Display side External Device side External Device side
. D-Sub 9pin (socket) Terminal Block Terminal Block R
Termination . . Termination
resistance | Pin | Signal name Shield Pin |Signal name Shield Pin [Signal name| resistance
100Q LT 1000
1 RDA 14 + D R 14 +
Display 2 | rDB 16 - e S e -
3 | spba 15 | s6 [——= 15| sG
7 |soB )i d 0+ T 1
5 SG
4 ERA
8 CSA
9 ERB
6 CSB
Shell FG
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Temperature Controller MODBUS SIO Driver

2C)
¢ 1:1 Connection
Display side
Terminal Block . .
External Device side
Signal name ; i
Displa J ,...S.t]!e.l.q-., Terminal Block Termination
Pay TERMRX — Pin |Signal name| resistance
' A ! H 100Q2
[ 1 RDA [« / ——> 14 + %
7L_I RDB |- 5 16 -
CA3-ADPTRM-01| SDA : 15 SG
CA4-ADPONL-01 . :
SDB '
SG . /
FG
User-created cable
e 1:n Connection
Display side
Terminal Block External Device side External Device side
Signal name Shield Terminal Block Terminal Block o
Display g 3, - - . - - Termination
TERMRX [—7 FY Pin |Signal name Shield Pin |Signal name| resistance
: ; R >, 1000
[ = RDA [e 14 + A 14 +
// L[ roB |& 6| - 4—.] \——> 16 | -
CA3-ADPTRM-01 |  SDA : 15 SG 3 15 SG
CA4-ADPONL-01 SDB  b—d A T ;l_
SG
FG

User-created cable
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Temperature Controller MODBUS SIO Driver

2D)
¢ 1:1 Connection

Display side

D-Sub 9pin (plug) ) )
External Device side

Pin | Signal name Shield ;
Displat 9 JE Terminal Block Termination
play 1 |TERMRX [— 2% | Pin [Signal name| resistance
: N 1000
2 RDA  [& / ——p 14 + %
7 RDB  |e= \—~—> 16 -
3 SDA : . —— 15 | SG
CA4-ADPONL-01 f T
8 SDB T Vo
5 SG - B ;
Shell FG —T
User-created cable
e 1:n Connection
Display side
D-Sub 9pin (plug) ) External Device side External Device side
- Pin | Signal name Shleld, Terminal Block . Terminal Block Termination
Display 1 |TERMRX —F % | Pin [Signal name[ ~ Shield Pin_[Signal name| resistance
2 | RDA [ /A,"‘,=14 AT e |+ El
7 | ROB |« \—-—> 16 [ - e Mle |-
3 | spbA 15 | sG —+—15 | sG
CA4-ADPONL-01 3 SDB J:_
5 SG
Shell FG

A
v

User-created cable
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Temperature Controller MODBUS SIO Driver

2E)

1:1 Connection

Display side

Terminal Block

External Device side

Signal name Shield Terminal Block o
) goTTTTTTTenes S Termination
Display TERMRX[— /% | Pin |Signal name| resistance
RDA ¢ :' A N 100Q
] e o M
/1 RDB |e ——> 16 -
CA3-ADPTRM-01 SDA |, 115 SG
CA3-ADPCOM-01 SDB H H
SG . :
FG
User-created cable
* 1:n Connection
Display side
Terminal Block _ External Device side External Device side
Signal name __ Shield Terminal Block Terminal Block o
. - ey Termination
Display TERMRX [— ;% | Pin [Signal name Shield Pin |Signal name| resistance
! FE T, 7 1000
; AL Al
[ T RDA ~ / r 14 + 14 + %
// - RDB [e ——l 16 - e S 16 -
CA3-ADPTRM-01 SDA | 15 SG T | 15 SG
CA3-ADPCOM-01 SDB \ S T 1
SG > ’
FG

v

A

User-created cable
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Temperature Controller MODBUS SIO Driver

2F)
¢ 1:1 Connection

Display side External Device side
.. D-Sub 9pin (socket) Terminal Block —
Termination . Termination
resistance | Pin |Signal name Shield Pin |Signal name| resistance
100Q 100Q
1 |[DATA+ [« 14 + %
Display 2 |DATA- 16 -
3 NC 15 SG
7 NC
5 GND(SG)
4 ERA
8 CSA
9 ERB
6 CSB
Shell FG
e 1:n Connection
Display side External Device side External Device side
Termination D-Sub 9pin (socket) . Terminal Block . Terminal Block . - ion
resistance | Pin |Signal name Shield Pin [Signal name Shield Pin |Signal name| resistance
1000 T 1000
% 1 |[DATA+ » 14 + N T 14 + %
Display 2 |pAaTA- 6| - |« S| -
3 | NC 15 | SG ‘———— 15 | SG
7 [ ne | 00 T 1
5 |GND(SG)
4 ERA
8 CSA
9 ERB
6 CSB
Shell | FG

GP-Pro EX Device/PLC Connection Manual 38



Temperature Controller MODBUS SIO Driver

2G)
e 1:1 Connection
Display side External Device side
Terminal block Terminal Block N
o ) Termination
Termination | Signal name Shield Pin |Signal name| resistance
resistance™1 R SRR EETY 100Q
% RDA |¢— A——> 14 + %
Display RDB |e—: /\_._..> 16 _
SDA |— . —— 15 | SG
SDB |— P
SG_ | P
ERA [— P
CSA <——|'. b
ERB : Vo
CSB <—J Ll
* 1:n Connection
Display side External Device side External Device side
Terminal block Terminal Block Terminal Block -
. i Termination
Termination | Signal name Shield Pin |Signalname| ~ Shield Pin [Signal name| resistance
resistance*1 FDA e S S " N PR AN 12 + 100Q
Display % RDB |e ' /\—n—-yl: I" 16 - ‘:I \_7._"" 16 -
SDA L sG |——15 | sa
SDB L
SG
ERA
CSA
ERB
CSB

*1  The resistance in the Display is used as the termination resistance. Set the value of the DIP Switch on the
rear of the Display as shown in the table below.

DIP Switch No. Set Value
1 OFF
2 OFF
3 ON
4 ON
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Temperature Controller MODBUS SIO Driver

2H)
¢ 1:1 Connection

Display side External Device side
o D-Sub 9pin (plug) Terminal Block o
Termination . Termination
resistance Pin | Signal name Shield Pin [Signal name| resistance
100Q ST 1000
3 LINE(+) |+ —> 14 + %
Displa AN AWEN
spay 8 LINE(-) : > 16 -
1 NC i ,—.15 | SG
2 NC P
5 | GND(sG) [ P
4 RSRTS) | bl
6 5V ': Lo
7 NC : L
9 NC | Ll
r .......... >
Shell FG ‘
e 1:n Connection
D-ISDLiJi)pSI)ap);nSi(c:)Ieug) External Device side External Device side
Termination . . . Terminal Block . Terminal Block Termination
resistance Pin | Signal name Shield Pin [Signal name Shield Pin [Signal name| resistance
1000 SR 100Q
STy I I e N R
Display 8 | Unep 16 | - : \—'—*’ 16 | -
1| e 15| s6 H——{15]| sG
2 ne |2 T —_L
5 | eND(sG) P
4 | rsRry) |
6 [ v | b
7 | N ' I
9 NC | L
shel | F6 T ]

IMPORTANT The 5V output (Pin #6) on the Display is the power for the Siemens AG’s PROFIBUS
connector. Do not use it for other devices.

NOTE I

* In COM on the GP-4107, the SG and FG terminals are isolated.
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Temperature Controller MODBUS SIO Driver

2l)
¢ 1:1 Connection

Display side
Terminal Block . )
Sianal Shield External Device side
ignal name .
, L JARERREREEEEEE ) Terminal Block .
Display TERMRX [— .\ | Pin [Signal name| resistance
RDA e . AL N N 1000
1, = TT/\ | H=
7@ RDB | N P ~
PFXZCBADTM1 SDA — 15 SG
SDB
SG
FG
User-created cable
¢ 1:n Connection
Display side
Terminal Block ] ) . .
- . External Device side External Device side
Signalname [~ Shield Terminal Block Terminal Block _
i ! N . - Termination
Dpey TERMRX ;% | Pin [Signalname[ Shield Pin |Signal name|resistance
< PEFEERIN A 1000
[ —1 RDA ~: / :. -: > 14 + :, :, :‘ 14 +
//:I RDB |14 \—.-bl: > 16 _ = / \ > 16 _
PFXZCBADTM1 SDA  — i _—— 15 SG —— 15 SG
SDB 5 _l_
SG
FG

\4

A

User-created cable
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Temperature Controller MODBUS SIO Driver

2J)

¢ 1:1 Connection

Display

¢ 1:n Connection

Terminal Block

External Device side

Termination
Pin |Signal name| resistance
D1 100Q
7
DO 16 _
(m N\ 15 | sG

Termination External Device side Externall Device side
;ezs[;gzr}ic\elv) Terminal Block . Terminal Block Termination
. \ Pin [Signal name Shield Pin |Signal name| resistance
Display D1 m R 2200(1/4W)
+ N T +
DO g 16 _ 4_,_/' : > 16 -
GND \ v
(1) 15 SG Y — 15 SG
i} '
User-created Cable
Number Name Notes

)

RJ45 RS-485 Cable (5m) by Pro-face

PFXZLMCBRJR81

GP-Pro EX Device/PLC Connection Manual

42



Temperature Controller MODBUS SIO Driver

Cable Diagram 3

Displ
p. =V Cable Notes
(Connection Port)
COM port conversion adapter by Pro-face
. CA3-ADPCOM-01
GP3000" (COM1) +
AGP-3302B (COM2) 3A Terminal block conversion adapter by Pro-face Cable lenath:
* gtn:
GP;4 01TM (COM1) CA3-ADPTRM-01 500m or less
ST*? (COM2) +
LT3000 (COM1) User-created cable
3B User-created cable
Online adapter by Pro-face
CA4-ADPONL-01
+
3C Terminal block conversion adapter by Pro-face
CA3-ADPTRM-01
GP3000* (COM2) + Cable length:
User-created cable 500m or less
Online adapter by Pro-face
CA4-ADPONL-01
3D +
User-created cable
COM port conversion adapter by Pro-face
CA3-ADPCOM-01
+
pc 3E Terminal block conversion adapter by Pro-face Cable length:
CAS-ADJI:’TRM-Ol 500m or less
User-created cable
3F User-created cable
GP-4106 (COML1) 3G User-created cable Cable length:
500m or less
GP-4107 (COM1) )
GP-4*03T"® (COM2) 3H User-created cable ggg{f c'frnlgtsz
GP-4203T (COM1)
RS-422 Terminal Block Conversion Adapter by Pro-face
x| *7
GP4000*8 (COM2) 3 PFXZCBADTM1 Cable lenath:
GP-4201T (COML1) * Co0m o Igss.
SP5000 (COM1/2) User-created cable
3B User-created cable
LT-4*01TM (COM1) RJ45 RS-485 Cable (5m) by Pro-face Cable lenath:
LT-Rear Module (COML1) 3] PFXZLMCBRJR81 200m or Igss.

*1  All GP3000 models except AGP-3302B
*2  All ST models except AST-3211A and AST-3302B
*3  All GP3000 models except GP-3200 series and AGP-3302B
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*4

*5
*6
*7

Temperature Controller MODBUS SIO Driver

Or%z}the COM port which can communicate by RS-422/485 (2 wire) can be used.
"m IPC COM Port" (page 5)

Except GP-4203T
All GP4000 models except GP-4100 Series, GP-4*01TM, GP-4201T and GP-4*03T

When using a Terminal Block Conversion Adapter (CA3-ADPTRM-01) instead of the RS-422 Terminal Block
Conversion Adapter, refer to Cable Diagram 3A.

IMPORTANT I 'Sl'girglsnal number used for communication differs depending on the External Device
Terminal numbers corresponding to each series are shown below. SG terminals are
not available for these series. Apply masking using insulation tape, etc. Implement
Type D installment to the shield connected to the FG.

Series + -
PXG4 7 8
PXG5/PXG9 1 2
PXR3 15 14
PXR4/PXR7 7 8
PXR5/PXR9 1 2
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Temperature Controller MODBUS SIO Driver

3A)

1:1 Connection

Display side
Terminal Block . .
) External Device side
Signalname| ~_ Shield Terminal Block
Display . B \ ; Termination
TERMRX [— fo Signal name resistance
-l At Ly 1000
(L1 RDB [e - %
CA3-ADPTRM-01 SDA |
CA3-ADPCOM-01 SDB : Voo
SG
Fe
User-created cable
e 1:n Connection
Display side
Terminal Block ) External Device side External Device side
Signalname| ____Shield  Terminal Block Terminal Block
. R RS ) Termination
Display TERMRX [— ;%\ [Signalname[ _ Shield_ Signal name|  resistance
o TN PR AT 1000
[ I:I RDA ‘.:l / :. n':r + :, :. .‘I +
// L1 RDB  |¢ s - e e
CA3-ADPTRM-01 SDA _"
CA3-ADPCOM-01 SDB J R 1
SG o L
e

v

A

User-created cable
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Temperature Controller MODBUS SIO Driver

3B)
¢ 1:1 Connection

Display side External Device side
D-Sub 9pin (socket) Terminal Block o
Termination . . ; - Termination
rasistance Pin  [Signal name 5h|e|d‘ Signal name|  resistance
10002 1 RDA |« '.' A oy + %LOOQ
Display % 2 RDB | -' / .' " _
3 | sbA |— P
7 | SDB |— P
5 SG :
4 ERA ::I
8 | csaA T v
9 ERB :l Vo
6 | CSB : s
.......... 4,'
shell | FG |—T
¢ 1:n Connection
Display side External Device side External Device side
D-Sub 9pin (socket) Terminal Block Terminal Block
Termination - - Shield n ) N Termination
resistance Pin_|Sgnainame ~Shield Signal name '___S_f]I_e_It_i_,‘ Signal name|  resistance
1009% 1 RDA |e—: AN < :' A :' -“ N %1009
Display 2 RDB |« '-' / \ _._..": "‘ - 1—‘:’ \_‘—P:' : -

3 | sbA | P | Vi

7 | spB | 1

5 | sc | P

4 ERA ::I : :

8 | csa | I

9 | ERB :| Vo

6 | csB |+ i

shell | FG | Y .
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Temperature Controller MODBUS SIO Driver

3C)
¢ 1:1 Connection

Display side
Terminal Block

External Device side

Signal name Shield Terminal Block
Display TERMRX —— i [Signalname|  Termination
RDA |« A—

[I:I
#RDB:

CA3-ADPTRM-01 SDA
SDB
SG

FG 17T ’

/, > i %1009

CA4-ADPONL-01

User-created cable
e 1:n Connection
Display side
Terminal Block External Device side External Device side
Signal name Shield Terminal Block Terminal Block
Display TERMRX —— % [Signainame| shield [signainame| TerTnaton
[ =] R o A+ AT %1009
l/ LIl roB e / \—> - «J \—> -
CA3-ADPTRM-01| SDA (=
CA4-ADPONL-01 SDB '.“ '.‘ :.- as
SG L
F6 17T )

A

A\ 2

User-created cable
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Temperature Controller MODBUS SIO Driver

3D)
1:1 Connection

Display side
D-Sub 9pin (plug)
. _ ) External Device side
P|n S|gna| name Shleld Termina| BlOCk
Displa ST - . it
play 1 |TERMRX [— /% [Signalname| ~ Termination
‘ A N resistance
2 RDA [« / — + %mog
7 RDB |« \——> -
3 | SDA |= b
CA4-ADPONL-01 ' v
8 SDB T . '
5 SG
shel | F6 |—T
User-created cable
¢ 1:n Connection
Display side
D-Sub 9pin (plug) External Device side External Device side
Pin | Signal name Shield Terminal Block Terminal Block
Display 1 |TERMRX [— % |Signalname| ~ _Shield |Signal name L‘Zﬁgg‘:;fn
2 RDA &= /A Lyl o+ A+ %,mm
7 | ROB |e \~—-—> e e
3 | spAa Pl B L
CA4-ADPONL-01 8 SDB -‘ '." :. _l_
5 | sc L
shel | FG  —1 T

User-created cable

\4
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Temperature Controller MODBUS SIO Driver

3E)

1:1 Connection

Display side
Terminal Block . .
Shield External Device side
Signal name| ~___>Meld Terminal Block
Display TERMRX —= s’ K Signal name Ter_mination
! A oo resistance
N v > 1000
(S et 1/ —=
/1 RDB |e — -
CA3-ADPTRM-01 SDA H
CA3-ADPCOM-01 SDB ' v
SG
Fe |
User-created cable
e 1:n Connection
Display side
Terminal Block . . . .
- Shield External Device side External Device side
Signal name P !_3 _____ . Terminal Block Terminal Block
Display TERMRX [ J % [Signal name Shield Signal name| ~ Termination
RDA K A ,' I‘.; n PN n resistance
[ = AN AN =
// - RDB |e — - i — -
CA3-ADPTRM-01 SDA
CA3-ADPCOM-01 SDB '.‘ ‘_‘ :' -------- -_T_
SG oo S
FG T

\4

A

User-created cable
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Temperature Controller MODBUS SIO Driver

3F)
¢ 1:1 Connection

Display side External Device side
D-Sub 9pin (socket) Terminal Block
Termination - . . inati
) Pin  |Signal name Shield Signal name| ~ Termination
resistance g emmennaas . 9 resistance
100Q % 1 |DATA+|e— A—— 1  + %1009
Display 2 |pAaTA- 4_,_/\_._... _
3 | Nnc | o P
7 NC ; P
5 |GND(SG)| :
4 ERA :I
8 | csA [« b
9 ERB :’
6 | CSB : L
---------- él'
shel | F6 |—7
¢ 1:n Connection
Display side External Device side External Device side
D-Sub 9pin (socket) Terminal Block Terminal Block
Termination : ) Shield ) ; : Termination
esistance | _Pin_|Sgnalname| SN e Signalname|  __Shield  —|Signalnamel | ciance
1000 1 |DATA+|e—t—A + fee—A— 4 %1009
Display % 2> |pATA- e / \_._._.". "| _ <—~J\—'-> -
3 [ ne | Pl L
T ne ] i 1
5 |onpse)| P
4 ERA ::I o
8 | csa [+ I
9 ERB ::l Vol
6 | csB Vol
Shell | FG |— T ¥
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Temperature Controller MODBUS SIO Driver

3G)
¢ 1:1 Connection

Display side External Device side
Terminal block Terminal Block
Sional Shield Sianal Termination
N Ignal nam Ignal nam i
Termination gnaineme) VT R gnainame|  resistance
resistance*1 RDA |e«— A AN B 100
Display % RDB |<— / \ .: I‘. > _ %
SDA ; o
SDB |— P
SG | P
CSA [+ bl
ERB ::l', o
CSB ; v
e 1:n Connection
Display side External Device side External Device side
Terminal block Terminal Block Terminal Block
i i . ' - Terminati
Termination | Signal name Shield Signalname] ~ Shield  [Signalname|  reistance
resistance*1 RDA |« AT, + W A "h‘l > + 100Q
Display % RDB < / \_._..> I‘_ - 4—-—' ‘—‘—P - %
SDA Do | L
SDB P 1
se |1 i
ERA ::I
CSA : I
ERB :| H
CSB L

*1  The resistance in the Display is used as the termination resistance. Set the value of the DIP Switch on the
rear of the Display as shown in the table below.

DIP Switch No. Set Value
1 OFF
2 OFF
3 ON
4 ON
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Temperature Controller MODBUS SIO Driver

3H)
¢ 1:1 Connection

Display side External Device side
D-Sub 9pin (plug) Terminal Block
Nesstanes [ _Pn_[sgaane] _ Sheld - [sgnaivane] - Ternaton
| 1009% 3 LINE(+) < :.’ A :' “I N + %‘IOOQ
Display 3 LINE() :: / \ :' -:. _
20 e
5 GND(SG) | b
4 RS(RTS) | !
6 5V
7 NC
9 NC |
shell | F@ |—T7TTTT g
¢ 1:n Connection
Display side External Device side External Device side
D-Sub 9pin (plug) Terminal Block Terminal Block
T?rm.irlatilsz Pin | Signal name Sh|eld Signal name ‘__$_h_ige_lq_,‘ Signal name L‘zrig‘t::éig”
1000% 3 LINE(+) |e—s—A—"% AT 1000
Display 8 LNEQ) |e—mi—d iy "‘J \_’ - %
2 NC 5 A 1
5 GND(SG) | P
4 |msmrs) | | P
s e |+ i
7 NC .
9 NC “;‘
Shell 6 —1 7T ’

IMPORTANT 8 The 5V output (Pin #6) on the Display is the power for the Siemens AG’s PROFIBUS
connector. Do not use it for other devices.

NOTE I * In COM on the GP-4107, the SG and FG terminals are isolated.
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Temperature Controller MODBUS SIO Driver

31)

¢ 1:1 Connection

Display side
Terminal Block . .
) External Device side
Signal name __Shield Terminal Block
Displa . S ; Termination
play TERMRX[— Y Signalname| i rce
« A N (N 100Q
< . > +
= R TN =
/L1 RDB |e — -
PFXZCBADTM1 SDA = H
SDB * Vo
SG O
FG —T
User-created cable
e 1:n Connection
Display side
Terminal Block ) External Device side External Device side
Signalname | ____Shield  Terminal Block Terminal Block
. K KN Termination
Display TERMRX |— ;% [Signal name Shield Signal name|  resistance
| N ST 1000
5] =T/ —{7 /i
//I:I RDB  |e1 — - ' N -
PFXZCBADTM1 SDA _:._ H ': l\ _________ ‘:‘ ,"
SDB J Vo 1
SG “. ____________ “_‘_,"’
e |

v

A

User-created cable
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Temperature Controller MODBUS SIO Driver

3J)

1:1 Connection

External Device side

Terminal Block
Signal name Termination
Display D1 " resistance

/o

%1 00Q

(1

1:n Connection

Termination External_ Device side Externall Device side
resistance Terminal Block Terminal Block
_ 2200011 4W)\ Signalname| ~__Shield  |Signal name rTeeSri’S"tZ‘:éE’”
Display D1 + A 220Q(1/4W)
Do = e i %
g} - o
User-created Cable
Number Name Notes
RJ45 RS-485 Cable (5m) by Pro-face
(1) PFXZLMCBRJRS81
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Temperature Controller MODBUS SIO Driver

Cable Diagram 4

Displ
ISp. = Cable Notes
(Connection Port)
COM port conversion adapter by Pro-face
. CA3-ADPCOM-01
GP3000"! (COM1) +
AGP-3302B (COM2) 4A Terminal block conversion adapter by Pro-face Cable length:
GP-4*01TM (COM1) CA3-ADPTRM-01 500m or less.
ST (COM2) +
LT3000 (COM1) User-created cable
4B User-created cable
Online adapter by Pro-face
CA4-ADPONL-01
+
4C Terminal block conversion adapter by Pro-face
CA3-ADPTRM-01
GP3000* (COM2) + Cable length:
User-created cable 500m or less
Online adapter by Pro-face
CA4-ADPONL-01
4D .
User-created cable
COM port conversion adapter by Pro-face
CA3-ADPCOM-01
+
“ 4E Terminal block conversion adapter by Pro-face Cable length:
IPC CA3-ADPTRM-01 500m or less
+
User-created cable
4F User-created cable
GP-4106 (COML1) 4G User-created cable gggf’ﬁ (')i”lgts:
GP-4107 (COML1) _
GP-4*03T"® (COM2) 4H User-created cable gggr's :ﬁ”lgg;
GP-4203T (COM1)
RS-422 Terminal Block Conversion Adapter by Pro-face
x| *7
GP4000™6 (COM2) 41 PFXZCBf\DTMl Cable length:
GP-4201T (COM1) 500m or Iess.
SP5000 (COM1/2) User-created cable
4B User-created cable
LT-4*01TM (COM1) RJ45 RS-485 Cable (5m) by Pro-face Cable lenath:
LT-Rear Module (COM1) 4) PFXZLMCBRJR81 200m or Igss.

*1  All GP3000 models except AGP-3302B
*2  All ST models except AST-3211A and AST-3302B
*3  All GP3000 models except GP-3200 series and AGP-3302B
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|

*4 O%the COM port which can communicate by RS-422/485 (2 wire) can be used.
"® IPC COM Port" (page 5)

*5  Except GP-4203T
*6  All GP4000 models except GP-4100 Series, GP-4*01TM, GP-4201T and GP-4*03T

*7  When using a Terminal Block Conversion Adapter (CA3-ADPTRM-01) instead of the RS-422 Terminal Block
Conversion Adapter, refer to Cable Diagram 4A.
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4A)
¢ 1:1 Connection

Display side

Terminal Block ) )
External Device side

Signal name _...Shield " terminal Block
Display TERMRX [— £ % |signalname | ~ Termination
! L resistance
[ T RDA |« / .:= A(+) %1009
/Q RDB |« > B(-)
CA3-ADPTRM-01 SDA = ' SG
CA3-ADPCOM-01 SDB B H
SG
FG
User-created cable
¢ 1:n Connection
Display side
Terminal Block ) External Device side External Device side
Signal name L Shield Terminal Block  Terminal Block
Displ : SN - - Termination
Isplay TERMRX ; A Signal name | Signal name resistance
[ C 1 RDA |« /A E: A(+) A(+) %1009
//:1 RDB [« el B(-) B(-)
CA3-ADPTRM-01 SDA —“ SG SG
CA3-ADPCOM-01 SDB 5 Y
SG s~ B
FG —‘]

A\ 4

A

User-created cable

NOTE » Connect External Devices using side connectors.
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4B)
¢ 1:1 Connection

Display side External Device side
D-Sub 9pin (socket) Terminal Block
eomres [P [owdr] v [Saulnane ] ermer
1000 1 | RDA |e—9—A—> A 1000
Display % 2 | RDB |e—t / \——> B(-) %
3 | sbA |— SG
7 | spB |—
5 | s |-
HEN
8 | csa <_—:|
9 | ErB
6 | csB :l
shell | FG |—T7777 7" ¥
e 1:n Connection
Display side External Device side External Device side
D-Sub 9pin (socket) Terminal Block ~ Terminal Block
ngii;:gﬂg Pin |Signal name Shleld Signal name | Signal name rTeeS’i’:tg‘:éE”
100¢2 1 RDA |[e—f—A—> A(+) A(+) 100Q
Display % 2 | RDB |e—t / L—+ B(-) B(-) %
3 SDA : SG SG
7 SDB
5 SG
4 ERA
8 CSA
9 ERB
6 CSB
Shell FG

NOTE » Connect External Devices using side connectors.
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4C)
¢ 1:1 Connection

Display side

Terminal Block External Device side

Signal name Shield Terminal Block
Display TERMRX .." ---------- ':"‘.‘ Signal name Termination
: 1o resistance
[ [ RDA : /* :' —  AM) %100(2
/1| ROB _|ei L—i»  B(-)
CA3-ADPTRM-01 | SDA SG
CA4-ADPONL-01 SDB
SG | H
FG
) User-created cable i
« 1:n Connection
Display side
Terminal Block External Device side External Device side
Signal name Shield Terminal Block ~ Terminal Block
Display TERMRX —— | 2| signalname | Signalname |  Termination
[ =] _Roa A AG) A(+) %rl%sclgance
'/ L1l roe e /\4_‘_, B(-) B(-)
CA3-ADPTRM-01 [ SDA . SG SG
CA4-ADPONL-01 SDB :'-
SG '
FG

v

A

User-created cable

» Connect External Devices using side connectors.
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4D)

1:1 Connection

Display side
D-Sub 9pin (plug)
. . External Device side
Pin | Signal name Shield Terminal Block
Display 1 |TERMRX K ",“. Signal name Ter_mination
! N H resistance
2 RDA |e /* —|  A(+) %1009
7 | RDB |& \—‘—> B(-)
3 | SDA |— SG
CA4-ADPONL-01 H .
8 SDB T :
5 SG ~ ;
Shell FG
User-created cable
« 1:n Connection
Display side
D-Sub 9pin (plug)
- . External Device side External Device side
. Pin | Signal name Shield Terminal Block  Terminal Block
Display 1 |TERMRX [ i Signalname | Signalname |  Termination
K ot resistance
2 RDA [« /" e A(+) A(+) %1009
7 | RDB |e \4—-—> B(-) B(-)
3 SDA P SG SG
CA4-ADPONL-01 3 SDB
5 SG
Shell FG

A 4

A

User-created cable

» Connect External Devices using side connectors.

NOTE I
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4E)
¢ 1:1 Connection

Display side
Ter.mlnal Block . External Device side
Signalname| ~____Shield Terminal Block
Display TERMRX [ £ % | Signalname |  Termination
H A H \ resistance
[ ] RDA ~:. / .' e A(+) %1009
/1 RDB e i B(-)
CA3-ADPTRM-01 SDA : : SG
CA3-ADPCOM-01 SDB i ' ;
SG
FG
User-created cable
¢ 1:n Connection
Display side

Terminal Block External Device side External Device side

Signal name Sh|eld’_ Terminal Block ~ Terminal Block
Display TERMRX [— /% | Signalname | Signalname | Termination
. N H N resistance
[ :] RDA < :‘ / I..‘ -: > A(+) A(+) %1009
// L RDB |& B(-) B(-)
CA3-ADPTRM-01 SDA SG SG
CA3-ADPCOM-01 SDB
SG
FG

A
v

User-created cable

 Connect External Devices using side connectors.

NOTE I
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4F)
¢ 1:1 Connection

Display side
D-Sub 9pin (socket)

Termination Pin  [Signal name
resistance REECEEEEETEE N

100Q % DATA+
Display DATA—

NC
NC
GND(SG)
ERA
CSA
ERB
6 | csB

Shell | FG

External Device side
Terminal Block

Signal name
> A(+)
B(-)
SG

Termination
resistance

%1009

O |0 |hlO|IN|WIN]|EF

¢ 1:n Connection

External Device side External Device side
Terminal Block  Terminal Block

Display side
D-Sub 9pin (socket)

Termination
resistance

Pin

Signal name

DATA+

Signal name

Signal name

Termination
resistance

A(+)

100Q2
Display %

DATA-

NC

NC

GND(SG)

ERA

CSA

O |0 | |OIN|IWIN]|PF

ERB

CSB

Shell

FG

A(t)

%IOOQ

B(-)

B(-)

SG

SG

NOTE I

» Connect External Devices using side connectors.
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4G)
e 1:1 Connection
Display side External Device side
Terminal block Terminal Block
- . - Terminati
Termination Signal name __Shield . Signal name r:;g;‘ﬁ;g”
resistance™1 RDA |e—= A Ly A(+) 1000
Display % RDB |¢—: /\_.'_I':.p B(-) %
SDA |—+ i~ SG
SDB |— P
$6_|— P
ERA
CSA T Vo
ERB -
CSB :] s
¢ 1:n Connection
Display side External Device side External Device side
Terminal block Terminal Block ~ Terminal Block
Termination | Signal name Shield Signalname | Signalname | ~ Termination
resistance*1 REEEETCEETE - resistance
% RDA [|e— /" el A+) A(+) %1009
Display RDB { —  B(-) B(-)
SDA SG SG
SDB
SG
ERA
CSA
ERB
CSB
NOTE I » Connect External Devices using side connectors.

*1  The resistance in the Display is used as the termination resistance. Set the value of the DIP Switch on the
rear of the Display as shown in the table below.

DIP Switch No. Set Value
1 OFF
2 OFF
3 ON
4 ON
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4H)
¢ 1:1 Connection

Display side External Device side
D-Sub 9pin (plug) Terminal Block
T?rmiqagzz Pin Signal name Shleld» Signal name 'rl'eesrir:t::(t)i;)n
1000 3 LNE() [« A AW %1009
Display % s LINE() 4_,_/ :' ‘: B(-)
1 NC : T SG
Y P
5 GND(SG) P
4 RS(RTS)
6 5V
7 NC . .
9 NC H ¥
Shell FG B )
* 1:n Connection
Display side External Device side External Device side
D-Sub 9pin (plug) Terminal Block ~ Terminal Block
Term_irlation Pin Signal name Shield Signal name | Signal name Ter.mination
f nce {1 ] e N resistance
| 100Q % 3 LINE(+) [ :" A > AM) A(+) %1 000
Display = 4——/ \—~+ B(-) B(-)

1 NG : i~  sG SG

2 NG 5

5 GND(SG)

4 RS(RTS) :

6 5V :

7 NC : :

9 NC B i

Shell 6 — T ;

IMPORTANT I The 5V output (Pin #6) on the Display is the power for the Siemens AG’s PROFIBUS
connector. Do not use it for other devices.

NOTE » Connect External Devices using side connectors.

* |In COM on the GP-4107, the SG and FG terminals are isolated.
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41)
¢ 1:1 Connection

Display side

Terminal Block

External Device side

Signal name

Terminal Block

Display

TERMRX ;N

Termination
resistance

Signal name

RDA

A

RDB

%1009

A

PFXZCBADTM1 SDA

ol A
/ \—> B(-)

SG

SDB

SG

FG

v

A

¢ 1:n Connection

Display side
Terminal Block

User-created cable

External Device side External Device side

Signal name . Sh'eld . Terminal Block ~ Terminal Block
Display TERMRX |—- &% [ Signalname | Signalname | Termination
U = RDA [¢= /A ‘_:= A(+) A(+) %1009
// L1 RDB |e iy : B(-) B(-)
PFXZCBADTMA SDA = . SG SG
SDB
SG
FG

A\ 4

A

User-created cable
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47)
¢ 1:1 Connection

External Device side
Terminal Block

. Sairame | - ermiaten
Display D1
A(+) %1009
(1) GND SG

¢ 1:n Connection

External Device side External Device side

Termination
resistance Terminal Block  Terminal Block
2200(1/4W) Signal name | Signalname |  Termination
Display D1 resistance
g A(+) A(+) %2200(1/4W)
Do B(-) B(-)
1) GND SG SG
Number Name Notes
RJ45 RS-485 Cable (5m) by Pro-face
(1) PFXZLMCBRJRS81

» Connect External Devices using side connectors.

NOTE I
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6 Supported Devices

The following table shows the range of supported device addresses. Please note that the actually supported range
of the devices varies depending on the External Device to be used. Please check the actual range in the manual of
your External Device.

Input address of external device in the dialog below.

I\ peiceric [rci ] 3
o [=[[ooo1
Back | oar
ale|c 7|a]a
p|E|F 4[5]s

2 1]2]3

\Referenoe | 0 Ent

1. Device Set Device.

2. Reference The list of available identifiers is displayed.
Click the identifier to use and press "Select," and the address is entered.

3. Address Set Address.
The combination of identifier and address differs depending on the external device.

W The following description explains the memory maps for each parameter.

<When using Bit Data>
Bit Data (Read Only) : Function [02H]

Relative L Memory

Address Coil No. Type Contents Read-out Data
0000H 10001 Bit Alarml ON/OFF | 0: Alarm1 OFF, 1: Alarml1 ON
0001H 10002 (Reserved)
0002H 10003 (Reserved)
0003H 10004 (Reserved)
0004H 10005 Bit Alarm2 ON/OFF | 0: Alarm2 OFF, 1: Alarm2 ON
0005H 10006 (Reserved)

*1  Coil No. is the address that is assigned by the Display.
Example: For the parameter "Alarm1 ON/OFF" of Coil No. 10001, the Display’s designated address is as follows.
Use the first digit of the Coil No. (00001 -, 10001 -) to designate the device.
10001

Address (The last four digits of the Coil No.)
Device (The first digit of the Coil No.)
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Example: For the parameter "front surface control SV data" of Register No. 41003, the Display’s designated address
is as follows. Use the first two digits of the Register No.s (30001 -, 40001 -, 31001 - and 41001 -) to
designate the device.

41 003

Address (The last three digits of the Coil No.)
Device (The first two digits of the Coil No.)

« The External Device’s parameter data, when data transfer is performed, will have no
decimal places. Thus, in the Display, processing must be performed to correct the data.
For example, if a numeric display is used that includes decimal places, the "No. of
Decimals" of the "Display" settings must be used. Also, when writing data to a External
Device, it is necessary to write decimal values as integers.

Example: Register No. 41025°s "Output 1 Lower Limit"
External Device Display/Setting Value : 3.00%
Display value/setting : 3000

Please refer to your External Device manual for details (with/without a decimal point)
about data item setting value ranges.

6.1 PXH series
(=== This address can be specified as system data area.
Device Bit Address Word Address 32bits Notes
Read Only Word Data - 30257 - 31407 HiL LB 3112
Word Data 40001.00 - 45035.31 40001 - 45035 | LLs e 91] 2%

*1  Write disabled.
*2  This device is 32 bits in length. Only odd addresses can be assigned.

*3  When you write to the bit address, the Display reads the entire word, sets the defined bit, then returns the new
word value to the External Device. If the ladder program writes data to this word address during the bit write
process, the resulting data may be incorrect.

*4 43153 is an address to order writing in the nonvolatile memory (FIX processing).
Writing in the nonvolatile memory is performed by entering 1 (one) to the writing value.

NOTE * You can only set the Read Area Size for the system area available to use in the External
Device. Please refer to the GP Pro-EX Reference Manual for Read Area Size.
Cf. GP Pro-EX Reference Manual "LS Area (Direct Access Method Area)"
 Refer to the precautions on manual notation for icons in the table.

&~ "Manual Symbols and Terminology"
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6.2 PXG series
=== This address can be specified as system data area.
Device Bit Address Word Address 32bits Notes
Read Only Bit Data 10001 - 10013 - 1
Read Only Word Data (Internal) - 30001 - 30062 9™
Read Only Word Data i ) HiL *1
(Engineering Unit) 31001 - 31062 l;l m

Word Data (Internal) 40002.00 - 40628.15 40002 - 40628 9]
Word Data (Engineering Unit) | 41002.00 - 41628.15 41002 - 41628 9] ™

*1  Write disabled.

*2  When you write to the bit address, the Display reads the entire word, sets the defined bit, then returns the new
word value to the External Device. If the ladder program writes data to this word address during the bit write
process, the resulting data may be incorrect.

NOTE » You can only set the Read Area Size for the system area available to use in the External
Device. Please refer to the GP Pro-EX Reference Manual for Read Area Size.

Cf. GP Pro-EX Reference Manual "LS Area (Direct Access Method Area)"
 Refer to the precautions on manual notation for icons in the table.

&

"Manual Symbols and Terminology"
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6.3 PXR (AutoFIX) / PXR (NoAutoFIX) series

=== This address can be specified as system data area.

Device

Bit Address

Word Address

32bits

Notes

Bit Data

00001

Read Only Bit Data

10001 - 10016

10001

Read Only Word Data (Internal) - 30001 - 30037

HIL

Read Only Word Data

(Engineering Unit) i 31001 - 31037

Word Data (Internal) 40001.00 - 40120.15 40001 - 40120

Word Data (Engineering Unit) 41001.00 - 41120.15 41001 - 41120

*1 00001, 40001, and 41001 are addresses to order writing in the nonvolatile memory (FIX processing).
Writing in the nonvolatile memory is performed by entering 1 (one) to the writing value.

*2  Write disabled.

*3  When you write to the bit address, the Display reads the entire word, sets the defined bit, then returns the new
word value to the External Device. If the ladder program writes data to this word address during the bit write
process, the resulting data may be incorrect.

* You can only set the Read Area Size for the system area available to use in the External
Device. Please refer to the GP Pro-EX Reference Manual for Read Area Size.

Cf. GP Pro-EX Reference Manual "LS Area (Direct Access Method Area)"
* Refer to the precautions on manual notation for icons in the table.

&~ "Manual Symbols and Terminology"
6.4 PUM series (PUMA / B)
[=——1 This address can be specified as system data area.
Device Bit Address Word Address 32bits Notes

Read Only Word Data - 30001 - 34061

|H)'L|

Word Data 40001.00 - 45032.15 40001 - 45032

*1  Write disabled.

*2  When you write to the bit address, the Display reads the entire word, sets the defined bit, then returns the new
word value to the External Device. If the ladder program writes data to this word address during the bit write
process, the resulting data may be incorrect.

* You can only set the Read Area Size for the system area available to use in the External
Device. Please refer to the GP Pro-EX Reference Manual for Read Area Size.

Cf. GP Pro-EX Reference Manual "LS Area (Direct Access Method Area)"
* Refer to the precautions on manual notation for icons in the table.

&~ "Manual Symbols and Terminology"
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6.5 PUM series (PUME)
=== This address can be specified as system data area.
Device Bit Address Word Address 32bits Notes
Read Only Word Data - 30064 - 31003 HIL 9™
Word Data 40021.00 - 41016.15 40021 - 41016 | B i t'I 5| 2

*1  Write disabled.

*2  When you write to the bit address, the Display reads the entire word, sets the defined bit, then returns the new
word value to the External Device. If the ladder program writes data to this word address during the bit write
process, the resulting data may be incorrect.

NOTE * You can only set the Read Area Size for the system area available to use in the External
Device. Please refer to the GP Pro-EX Reference Manual for Read Area Size.

Cf. GP Pro-EX Reference Manual "LS Area (Direct Access Method Area)"
* Refer to the precautions on manual notation for icons in the table.

&~ "Manual Symbols and Terminology"

6.6 PUM series (PUMV /N /T)
=== This address can be specified as system data area.
Device Bit Address Word Address 32bits Notes
Read Only Word Data - 30001 - 34061 HiL 9™
Word Data 40017.00 - 45032.15 40017 - 45032 | . 5| 2

*1  Write disabled.

*2  When you write to the bit address, the Display reads the entire word, sets the defined bit, then returns the new
word value to the External Device. If the ladder program writes data to this word address during the bit write
process, the resulting data may be incorrect.

NOTE » You can only set the Read Area Size for the system area available to use in the External
Device. Please refer to the GP Pro-EX Reference Manual for Read Area Size.

Cf. GP Pro-EX Reference Manual "LS Area (Direct Access Method Area)"
 Refer to the precautions on manual notation for icons in the table.

&~ "Manual Symbols and Terminology"
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7 Device Code and Address Code

Use device codes and address codes when you set "Device Type & Address" for the address type of the data

display or other devices.

7.1 PXH series
Device Code
Device Device Name v Address Code
(HEX)
Read Only Word Data 3 0001 Value of (word address -1) divided by 2
Word Data 4 0000 Value of (word address -1) divided by 2
7.2 PXG series
Device Code
Device Device Name Address Code
(HEX)
Read Only Word Data (Internal) 30 0001 Value of (word address - 1)
Read_ Onl)_/ Word_ Data 31 0003 Value of (word address - 1)
(Engineering Unit)
Word Data (Internal) 40 0000 Value of (word address - 1)
Word Data (Engineering Unit) 41 0002 Value of (word address - 1)
7.3 PXR (AutoFIX) / PXR (NoAutoFIX) series
Device Code
Device Device Name Address Code
(HEX)
Read Only Word Data (Internal) 30 0001 Value of (word address - 1)
Read_ Onl)_/ Word_ Data 31 0003 Value of (word address - 1)
(Engineering Unit)
Word Data (Internal) 40 0000 Value of (word address - 1)
Word Data (Engineering Unit) 41 0002 Value of (word address - 1)
7.4 PUM series
Device Code
Device Device Name Address Code
(HEX)
Read Only Word Data 3 0001 Value of (word address - 1)
Word Data 4 0000 Value of (word address - 1)
GP-Pro EX Device/PLC Connection Manual 72




Temperature Controller MODBUS SIO Driver

8 Error Messages

Error messages are displayed on the Display screen as follows: "No. : Device Name: Error Message (Error

Occurrence Area)". Each description is shown below.

Item Description

No. Error number

Name of the External Device where an error has occurred. Device/PLC name is the title of

Device Name the External Device set with GP Pro-EX. (Initial value [PLC1])

Error Message Displays messages related to an error that has occurred.

Displays the IP address or device address of the External Device where an error has
occurred, or error codes received from the External Device.

Error Occurrence Area NOTE

* IP address is displayed as "IP address (Decimal): MAC address (Hex)".
 Device address is displayed as "Address: Device address"”.
» Received error codes are displayed as "Decimal [Hex]".

Examples of Error Messages
"RHAAO035:PLCL1: Error has been responded for device write command (Error Code: 2 [02H])"

NOTE  Refer to your External Device manual for details on received error codes.
 Refer to "Display-related errors” in "Maintenance/Troubleshooting Manual” for details on the

error messages common to the driver.

B Error Codes Unique to External Device

Error Code Description
0x02 Faulty address for coil or resistor
0x06 Busy condition
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